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Legal Notices

Copyright Notice

© 2003-2025 Medis Medical Imaging Systems bv. All rights reserved.

This manual is copyrighted and is protected by worldwide copyright laws and treaty provisions. No
part of this manual may be copied, reproduced, modified, published or distributed in any form or
by any means, for any purpose, without prior written permission of Medis medical imaging systems
bv. Permission is granted to freely print unmodified copies of this document as a whole, provided
that copies are not made or distributed for profit or commercial advantage.

Trademark Acknowledgments

Medis, QMass, QFlow and QStrain are registered trademarks of Medis Associated bv. DICOM is the
registered trademark of the National Electrical Manufacturers Association for its standards
publications relating to digital communications of medical information. All other brands, product,
and company names mentioned in this document are trademarks or registered trademarks of their
respective owners.
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Regulatory Information

Intended Use

Medis Suite MRCT is a software intended to be used for the visualization and analysis of MR and CT
images of the heart and blood vessels.

Medis Suite MRCT is intended to support the following visualization functionalities:
- cine loop and 2D review

- double oblique review

- 3D review by means of MIP and volume rendering

- 3D reformatting

- performing caliper measurements

Medis Suite MRCT is also intended to support the following analyses:

- cardiac function quantification

- MR velocity-encoded flow quantification

- anatomy and tissue segmentation

- signal intensity analysis for the myocardium and infarct sizing
- MR parametric maps (such as T1, T2, T2* relaxation)

Medis Suite MRCT is also intended to be used for:

- quantification of T2* results in MR images that can be used to characterize iron loading in
the heart and the liver

- MR velocity-encoded flow quantification of cerebral spinal fluid

These analyses are based on contours that are either manually drawn by the clinician or trained
medical technician who is operating the software, or automatically detected by the software and
subsequently presented for review and manual editing. The results obtained are displayed on top of
the images and provided in reports.

The analysis results obtained with Medis Suite MRCT are intended for use by cardiologists and
radiologists to support clinical decisions concerning the heart and vessels.

Indications for Use

Medis Suite MRCT is indicated for use in clinical settings where more reproducible than manually
derived quantified results are needed to support the visualization and analysis of MR and CT images
of the heart and blood vessels for use on individual patients with cardiovascular disease. Further,
Medis Suite MRCT allows the quantification of T2* in MR images of the heart and the liver. Finally,
Medis Suite MRCT can be used for the quantification of cerebral spinal fluid in MR velocity-encoded
flow images.

When the quantified results provided by Medis Suite MRCT are used in a clinical setting on MR and
CT images of an individual patient, they can be used to support the clinical decision making for the
diagnosis of the patient. In this case, the results are explicitly not to be regarded as the sole,
irrefutable basis for clinical diagnosis, and they are only intended for use by the responsible
clinicians.
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Limitations

Currently no limitations have been specified for Medis Suite MRCT 2025.

WARNINGS

@ Medis Suite MRCT must be used by cardiologists, radiologists, or trained technicians who are
qualified to perform cardiac analysis. If the analysis results are used to reach a diagnosis, the
results must be interpreted by a qualified medical professional. In clinical practice Medis Suite
MRCT should not be used for purposes other than those indicated in the section Intended Use.

@ Users must have sufficient proficiency in the language of the user manual, read the user
manual, and become familiar with Medis Suite MRCT to be able to obtain reliable analysis results.

Note on Monitor Aspect Ratio and Resolution

The shapes of objects and calipers displayed may get slightly distorted when the resolution is
set to an aspect ratio different than the monitor's physical aspect ratio. This distortion does NOT
affect the accuracy of measurements or analyses. To avoid distortion, set the resolution of the
monitor to an aspect ratio equal to the physical aspect ratio. LCD monitors typically operate best at
their native resolution. Microsoft Windows recommends a resolution when it has sufficient
information to do so.
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European Regulations

requirements of the Dutch Medical Devices Decree (Besluit Medische
Hulpmiddelen, Stb. 243/1995) and the European Medical Device Directive
0476 93/42/EEC.

C € Medis Suite MRCT is qualified as a class Ila medical device. It complies with the

Medis Suite MRCT is registered as a medical device (class Il) by the MoH in Turkey.

North American Regulations

Medis Suite MRCT has been cleared for market in the United States by the FDA (Food and Drug
Administration) under the provisions of Section 510(k) of the Food, Drug, and Cosmetic Act.

Caution

Federal law restricts this device to sale by or on the order of a physician.

Medis Suite MRCT complies with the requirements of the Canadian Medical Devices Regulations and
has been licensed as a Class Il medical device.

South American Regulations

Medis Suite MRCT complies with the requirements of INVIMA and has been licensed in Colombia as a
Class Il medical device. The QFlow 4D and QStrain modules have not been cleared for clinical use in
Colombia.

Asia-Pacific Regulations

Medis Suite MRCT complies with the requirements of the Australian Therapeutic Goods
Administration and has been licensed as a Class lla medical device.

Medis Suite MRCT complies with the requirements of the Japanese Pharmaceutical and Medical
Device Law and has been licensed as a Class Il medical device.
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The QFlow 4D and QStrain modules have not been cleared for clinical use in Japan.

Medis Suite MRCT complies with the requirements of the South Korean Medical Device Act and has
been licensed as a Class Il medical device.
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Conventions Used

The following conventions are used throughout this manual to indicate mouse and keyboard actions
and to refer to elements in the user interface.

Mouse

Click Press and release the primary mouse button. If you are left-
handed, you may have set the right mouse button as your
primary mouse button.

Right-click Press and release the secondary mouse button. If you are left-
handed, you may have set the left mouse button as your
secondary mouse button.

Middle-click Press and release the wheel button or the middle mouse button.
If you have a two-button mouse, press and release the left and
the right mouse button simultaneously.

Double-click Press and release the primary mouse button twice.

LMB, MMB, RMB Left Mouse Button (LMB), Middle Mouse Button (MMB), and Right
Mouse Button (RMB).

Keyboard

SHIFT/CTRL+click Press and hold down the SHIFT or CTRL key on your keyboard
while you click a button or object.

CTRL+O Press and hold down the CTRL key on your keyboard while you

press O, then release both keys. This example opens the dialog
window for opening a study.

Typographical Conventions

On the Display tab, select Names of buttons, fields, menus, menu options, and tab names
the Hide all drawings option. are capitalized and in bold.
View > Movie A sequence of menu options that you select to perform a specific

task, is indicated by angular brackets.

mass.ini Text that you type or that appears on the screen, such as file
names and file locations, is displayed in Courier New.
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Symbols Used

E Reference. Points to related documentation or to related
sections in the document that may be relevant in your situation.

Q Tip. Provides helpful information or an alternative working
method.

Note. Brings additional information to your attention.

Caution. Tells you to be careful when performing a task.

e b ©

Warning. Warns you for a potentially dangerous situation in the
image representation or analysis, which may lead to incorrect
results. You are advised to follow the instructions to avoid this.
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Introduction

1 About Medis Suite MRCT

Medis Suite MRCT is Medis' software solution for the analysis of cardiac MRl and CT studies. It
consists of a number of applications (apps) with specific functions: QMass, QFlow, QFlow 4D,
3DView and QStrain.

& Please be aware that certain applications (or sub parts) might not be available in particular
jurisdictions (see Section on Regulatory Information for information on this) or due to
restrictions in the license configuration.

Its automatic contour detection enables you to perform quantitative analyses quickly and
accurately. Medis Suite MRCT features MRI visualization and quantification tools for function
analysis including ventricular function analysis, strain analysis, and inward displacement analysis.
Next to that tissue characterization quantification tools for infarct size analysis (referred to as
Delayed Signal Intensity or DSI analysis), T2w analysis, Combined T2w-DSI, first-pass perfusion
analysis (referred to as time-signal intensity or TSI analysis), stress level function analysis (referred
to as comparison analysis), T1 analysis, T2/T2* analysis. Further, applications for Flow analysis,
including 2D flow analysis and 4D flow analysis which enables the 3D visualization and 2D
quantification of 4D flow MR studies.

Medis Suite MRCT also features CT visualization and quantification tools to either reformat
Computed Tomography Angiography (CTA) data, perform functional and strain analysis on that data
or to perform calliper measurements on the 2D visualization.

@ Medis Suite MRCT must be used by qualified medical personnel or trained technicians. If the
analysis results are used to reach a diagnosis, the results must be interpreted by a qualified
medical professional. Medis Suite MRCT should not be used for purposes other than those indicated
in the section Intended Use.

@ Medis Suite MRCT cannot perform the following analyses on CT reformatted data; infarct size
tissue analysis, T2w analysis, perfusion analysis, T1 analysis, T2 analysis, and T2* analysis.

@ Automatically and manually created contours can lead to incorrect results. Make sure to review
them and correct if necessary.
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Introduction

2

System Requirements

2.1 Hardware

Medis Suite MRCT:

A 64 bit processor

8 GB RAM

10 GB free disk space after the software is installed

A monitor with a screen resolution of 1.3 Megapixels (e.g. 1280 x 1024 pixel for a display
ratio 4:3, 1600 x 900 pixels for display ratio 16:9)

Sentinel license server:

A 32 or 64 bit processor
4 GB RAM
5 GB of available hard disk space

All hardware must be compliant with the operating system.

The requirement for the disk space does not take storage space for image data into
account. If you want to store images on the local machine, make sure that sufficient disk
space is available. Also note that client machines will cache image data from the server
temporarily on the local machine.

To view image data a dedicated graphics card supporting OpenGL and at least 512 MB
memory is recommended.

To connect your workstation with other machines in the network (e.g. a client-server
configuration, or receive and send images to a remote DICOM node) a network connection
will be required. A network interface card supporting at least 100 mbps is recommended.
For the license server, a workstation with a fixed IP address or a reserved IP address in the
DNS server is recommended.

2.2 Operating System

Medis Suite MRCT:

Microsoft Windows 10, 64-bit
Microsoft Windows 11, 64-bit
Microsoft Windows Server 2016, 64-bit
Microsoft Windows Server 2019, 64-bit
Microsoft Windows Server 2022, 64-bit

Sentinel license server:

Microsoft Windows 10, 32-bit and 64-bit
Microsoft Windows 11, 64-bit

Microsoft Windows Server 2016, 64-bit
Microsoft Windows Server 2019, 64-bit
Microsoft Windows Server 2022, 64-bit
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Introduction

3 Support

Medis is committed to offering high-quality products and services. If you have questions about the
software or if you would like to make suggestions for improvements in the software or the
documentation, please contact the Medis helpdesk.

If you contact the Medis helpdesk by e-mail, mention the name of the software and the version
number in the subject field.

To look up the version number of your software, select the application menu by clicking - in
the upper right corner of the Medis Suite window, and then Help > About....

North and South America

Medis medical imaging systems, Inc.
E-mail: support@medisimaging.com
Telephone: +1 919 278 7888 (working days 9.00-17.00 EST)

Europe, Africa, Asia, and Australia
Medis medical imaging systems bv

E-mail: support@medisimaging.com
Telephone: +31 71 522 32 44 (working days 9.00-17.00 CET)
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Getting Started

4 Startup

To start Medis Suite, double-click the Medis Suite icon on the desktop, or select Medis Suite from
the Windows start menu.

Medis Suite provides its graphical user interface in the following languages: English, German,
Spanish, Italian, French, Japanese, and Portuguese.

(D The active language can be set in the Medis Suite options dialog (click . > Tools >
Options, and select the General tab). If the language of your Windows operating system is
supported by Medis Suite, it will be activated automatically on the first startup.

@ After Medis Suite has been installed on a computer system, it must be configured with the
appropriate licenses, and the ‘post install test’ must be executed, to ensure that the
system is installed and configured properly and will provide you with accurate clinical
results. For more information on how to configure the licenses and how to execute the post
install test, refer to the Installation Manual. Without a valid license and a successfully
executed post install test, it will not be possible to load data in Medis Suite.

4.1 Logon to Medis Suite

Dependent on your Medis Suite configuration, you may have to specify your Windows username and
password to log on to Medis Suite.

Welcome to Medis Suite

Enter your Windows network credentials to logon.

N User: |

Password:

| Domain |yourdomain.local |

Log on as the current Windows user

M Medis | immms oo

MEDICAL IMAGING

@ If the user logon to Medis Suite is enabled, and you logon to Medis Suite as a different user
than the one that is logged into the Window system, be aware that mapped network drives
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Medis Suite MRCT Applications

that are available to the Windows user are not available in Medis Suite. You will not be able
to import or export data from those mapped network locations.

If user logon to Medis Suite is disabled, to prevent unauthorized access to Medis Suite the
Windows operating system must be configured such that no unauthorized logon to Windows
can be achieved.

To prevent unauthorized access to Medis Suite, lock the Windows system or close Medis Suite
when you leave the computer system. Both Windows and Medis Suite provide configuration
options to lock or close automatically when they are not actively used.

While Medis Suite is running, it will use computer resources such as a license and computer
memory that will thereby no longer be available for other users. To free resources and make
them available for others, close Medis Suite when you are not using it. Medis Suite provides
configuration options to close automatically when it is not actively used.

4.2 Role Based Access Control

Medis Suite offers ‘role based access control’ to some of its functionalities. Specific functionality of
Medis Suite may be accessible or inaccessible for individual users that logged on to Medis Suite.
Role based access control is configured by your system administrator.

The following functionalities may or may not be available for you, dependent on your role:

- General (startup, view, analyze),

- Access to advanced options,

- Import data into a repository,

- Export data from a repository,

- Delete data from a repository,

- Anonymize data from a repository,

- Export report and results,

- View and export pay per use voucher details.
- Access to shared repositories.

4.3 Licenses and Pay-Per-Use Vouchers

Your workstation needs access to licenses and/or pay-per-use vouchers in order to work with Medis
Suite and the installed apps. The availability of specific application functionality may be dependent
on the available licenses and/or pay-per-use vouchers.

For an overview of your current license configuration, click H > Tools > Show available
licenses.... Select a license or a pay-per-use voucher from the overview to review its details. This
includes license expiration date, other users that have claimed a license, or an overview of claimed
pay-per-use tokens.

To refresh the overview of available licenses and pay per use vouchers, click - To start the CMS

License Manager application, click ﬂ To save an overview of your pay per use vouchers, click

The overview of claimed pay-per-use tokens can be filtered to only show the tokens that have been
claimed during a certain time period, or by specific users. To filter by time, use the available
dropdown box to set a predefined date range (e.g. “Last month”) or specify a custom date range.
To filter by user use the available dropdown box and select the users that you want to include or

exclude in the filter. To export the filtered list of claimed pay-per-use tokens, click ﬂ
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Medis Suite MRCT Applications

Changes to the license configuration (including installation of new licenses or pay-per-use
vouchers) can only be made from the CMS License Manager application. Please contact your
system administrator for additional information.

Medis Suite will show a warning when your Medis Suite license is about to expire (30 days by
default) or when any of your pay-per-use vouchers is getting close to be fully redeemed (30
tokens by default). The warning thresholds can be set in the Medis Suite options.

4.4 Overview Medis Suite Application

Medis Suite MRCT is the Medis software solution for the visualization of magnetic resonance (MR),
computed tomography (CT), and X-ray angiographic (XA) images. It provides intuitive tools for
displaying MR, CT and XA images in 2D, and provides tools for easy and quick measurements.

Medis Suite integrates applications that can provide advanced manual and automated image
analysis. Results from the integrated applications will be gathered in Medis Suite and can be used
to generate a combined report.

The Medis Suite software solution offers quantification results that enable cardiologists and
radiologists to review MR, CT and XA images, and it provides a solid basis for clinical decision
making.

The main workspace of Medis Suite consists of toolbars, several workspace panes, and the central
window area.

\ £

J

You can customize the main workspace by hiding or moving the workspace panes and toolbars. Any
changes that you make to the main workspace are saved for each Windows user.

The central window area holds the Browser, View and Report tabs that are provided by Medis
Suite. Next to that, the central window is the area where integrated Medis Suite applications will
be displayed after launching them.

As an example, the next image shows the QMass app running embedded in the Medis Suite
environment. Multiple apps can be open at the same time; every app instance will be shown on its
own tab page inside the central window. The results of each app can be combined in a single Medis
Suite report.
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Medis Suite MRCT Applications

Using Drag ‘n Drop (D’nD) one can load data into any of the Medis Suite MRCT applications.
Depending on the modifier keys pressed during the D’nD Medis Suite MRCT will have a different load
behavior:

D’nD Data will be added to the current session and the first series will be made
active.

D’nD + Shift Data will be added. Current active series will remain active.

D’nD + Ctrl Current data will be closed. New data will be loaded. First series will be made
active.

For further explanation please refer to the Medis Suite User Manual.
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Medis Suite MRCT Applications

5 The Medis Suite MRCT Applications

This chapter provide an overview of main application windows of Medis Suite MRCT.

5.1 Overview QMass Application

QMass offers automatic contour detection that enables you to perform quantitative analyses quickly
and accurately. QMass features ventricular function analysis, infarct size analysis (referred to as
Delayed Signal Intensity or DSI analysis), T2w analysis, Combined T2w-DSI, first-pass perfusion
analysis (referred to as time-signal intensity or TSI analysis), stress level function analysis (referred
to as comparison analysis), T1 analysis, T2/T2* analysis. QMass can also read CT reformatted data
and perform functional analysis on that data

The QMass main workspace consists of a set of toolbars, a study matrix and three views. Depending
on the type of study, its orientation and the chosen analysis, icons are either enabled/visible or
disabled/invisible in their respective toolbars.

Draft session 1/7/2015 8:44 AM *
o i/ my-~ Tool Bar
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AL 1 2 3 4 5 6 7 8 o BN 12 13 14 15

I o Pu
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B-TFE_BH 4CH

9

{

)
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B-TFE_BH LVOT
8mm
116 Ph: 1/25

BTFE_BH SA

100 %
SBTFE_BH SA WL 206 379

S601  S701

Menu

The application menu is accessible through the * button and can be used to, for example, reset
the layout, to view graphs, to view reports, to view study parameters, to change settings, to detect
and edit contours, to undo or redo actions and to cut, copy and paste elements.

Study Matrix
The study matrix shows an overview of the images of the selected series.

Active View
The viewport shows the image selected in the study matrix.
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Medis Suite MRCT Applications

Scanline View

The scan line views present the slice position of the selected series. In the first two views, you can
switch to another series by right-clicking and selecting the new series. You can also pan, and you
can zoom in or zoom out by using the sliders.

Thumbnail View

The thumbnail view shows thumbnail images of the selected series. The thumbnail view shows
either phase images or modulus images. This can be configured through the application menu. The
thumbnail marked with the red border corresponds to the image displayed in either the phase view
or the modulus view.

Toolbar

The toolbar area consists of a Medis Suite toolbar and several QMass toolbars. The QMass toolbars
can be used for example to access the application menu, to start a movie, to show a graph, to
access the main settings, and to perform some basic image manipulations like panning or zooming.
The QMass toolbars can also be used to undo and redo some actions, to create a snapshot, to detect
or draw contours and to edit or delete them.

For further explanation please refer to the QMass User Manual.

5.2 Overview QFlow Application

QFlow can be used for the quantitative analysis of velocity-encoded MR studies.

The QFlow main workspace consists of a set of toolbars, a phase view, a modulus view and a
thumbnail view. The application menu is accessible through a menu icon in the toolbar.

W oeeee Draft session 1/8/2015 12:20 PM *
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Menu

The application menu is accessible through the * button and can be used for example to reset the
layout, to view graphs, to view reports, to view study parameters, to change settings, to detect
and edit contours, to undo or redo actions and to cut, copy and paste elements.

Phase view
The Phase view shows a velocity image of the selected series.
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Modulus View
The Modulus view shows a modules image of the selected series.

Thumbnail View

The Thumbnail view shows images in each timepoint of the selected series. It can either show the
modulus or phase images. This can be configured through the application menu. The thumbnail
marked with the red border corresponds to the image displayed in either the phase view or the
modulus view.

Toolbar

The toolbar area is divided into two groups; Medis Suite-specific group and QFlow-specific group.
The QFlow toolbars can be used for example to access the application menu, to start a movie, to
show a graph, to access the main settings, and to perform some basic image manipulations like
panning or zooming. The QFlow toolbars can also be used to undo and redo some actions, to create
a snapshot, to detect or draw contours and to edit or delete them (part of Medis Suite-specific

group).

For further explanation please refer to the QFlow User Manual.

5.3 Overview QFlow 4D Application

QFlow 4D is the Medis software solution designed to support the 3D visualization and 2D
quantification analysis of 4D flow MR studies. It allows cardiologists, radiologists, and technicians to
quantify arterial and transvalvular blood flow. QFlow 4D supports a double-oblique view layout that
includes a transverse view of the phase image and MIP of the data. Once the required view is
selected, a quantitative flow analysis can be performed.

The main workspace of QFlow 4D consists of a menu bar, toolbars, workspace panes and the central
window area which is comprised of Double Oblique, 3D-MIP and Velocity image viewports. There
are also results and properties panes.
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H A Results

@ correction

1st; 25%

Speed [m/s] o Speed [cmy/s] ®) : [ Fow Analysis
. 5 % : N Velocity View g S
o) - J
. . oW
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er  View  QFlow 4D Stable Daily 1.0 #1 Distal Descending Ao

You can customize the workspace by hiding, resizing or moving the workspace panes and toolbars.
Any changes that you make to the workspace are saved for each individual Windows user.
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Double Oblique view
The main purpose of the Double Oblique views is used to determine the plane of interest to be used
for Flow Analysis in Medis Suite MRCT. They show the orthogonal views of the 3D volume.

Velocity View
The Velocity View is a viewport that shows the velocities in the selected plane in the Double
Oblique View.

MIP View
The MIP View is a viewport that shows the selected series rendered in 3D.

Results Pane

The Results pane shows the following:

« It shows standard procedures, i.e. measurements, annotations and snapshots performed on the
series that is loaded in the viewport.

o It shows the Background Correction.

o It shows the list of Flow Analyses.

Properties Pane

The Properties pane shows the properties of the selected procedure. You can modify Medis Suite
MRCT standard procedures, i.e., measurements, annotations, or snapshot procedures as well as the
Flow Analysis reconstructions.

Toolbar

The QFlow 4D toolbar provides several functionalities, such as access the application menu, Cine
actions (play, pause, stop, etc.), performing some basic image manipulations like panning or
zooming and starting procedures.

For further explanation please refer to the QFlow4D User Manual.

5.4 Overview 3DView Application

3DView can be used for the visualization of Computed Tomography Angiography (CTA) and Magnetic
Resonance Angiography (MRA) images. It provides intuitive tools for manipulating CTA/MRA images,
displaying CTA/MRA images in 2D and 3D, and provides tools for easy and quick measurements.

The main workspace consists of toolbars, multiple workspace panes, and the image view.
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Image View

The Image view displays the currently loaded volume 2x2 in several different representations. By
default, the images in the Image View display a number of patient details and volume information.
You can show or hide these overlays from the image.

Workspace Panes

The Workspace panes consist of the following:

« The Results pane lists the results of actions performed on the volume: annotations,
measurements, snapshots, reformats and sculptures.

« The Properties pane shows the properties of the selected result. You can always modify the
Label, but you must activate a reformat or sculpture to view or modify their other properties.

« The LUTs Pane is used to enhance visualization in the 3DVR view.

Toolbar

The 3DView toolbar offers to access the application menu, basic Cine functionality, some image
manipulations techniques such as like panning or zooming, and a set of procedures applicable to
the application.

For further explanation please refer to the 3DView User Manual.

5.5 Overview QStrain Application

QStrain is meant to be used for myocardial assessment to determine the health status of the
myocardium. A global assessment can indicate several abnormalities in flow and tissue, thereby
quantifying the extent of these abnormalities.

Series Selection
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L. \§ 1@, " w5 ¢-%

001-s16

tf2d15-CINEZSAY(pakket)

Mitral Valve

) Wizard

Papillary Muscle

“ ;’ _\8 | Step

Toolbar

]

CINE viewport Analysis Selection

QStrain reads both MR and CT data. It allows 4 different types of analysis: Apical (LAX), SAX, Atrium
and Right Ventricle. Each slice can be assigned to its appropriate block depending on the
orientation and the analysis to be performed.

Series Selection
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The loaded images are grouped based on slices. Each slice contains a number of timepoints. The
slice can be assigned to a specific analysis by clicking on it.

CINE viewport
The CINE viewport allows visualization of the chosen series. On hovering, the movie starts playing.
If contours are available for that slice, an icon is shown on the top-left corner.

Analysis Selection
An analysis can be selected simply by clicking on a slice from the Series Selection pane and
subsequently clicking on one of the orientation blocks (A2C, A3C, A4C, Mitral Valve, etc.).
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Viewport
The Viewport provides visualization of the contour tracking based on the drawn contours for the ES
and ED phases.

Results/Graph Results/AHA Strain Results

These sections give an objective view of the myocardium. They show the results and graphs to
indicate the myocardium movement. The Results are simply medical values derived based on input
data and drawn contours.

Toolbar

The Toolbar exposes several utilities, such as, access to data-selection viewport, export of images,
movies and data, contour-related landmarks, other available analysis, and the current analysis
being shown.

For further explanation, please refer to the QStrain User Manual.
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